PRODUCT
REGISTRATION
USER GUIDE
# TABLE OF CONTENTS

Product Registration User Guide .................................................................................................... 1
Table of Contents ............................................................................................................................ 2
Introduction ..................................................................................................................................... 5
About the Application ..................................................................................................................... 5
    About the User Guide ................................................................................................................. 7
Users ........................................................................................................................................... 7
Organization ................................................................................................................................ 7
Navigation ................................................................................................................................... 8
Feedback ..................................................................................................................................... 9
Getting Started .............................................................................................................................. 10
    Logging in ............................................................................................................................... 10
Label Registration ......................................................................................................................... 12
    Label Applicant Search ........................................................................................................... 12
    Enter Applicant Information .................................................................................................. 15
    Brand Name Search ............................................................................................................... 15
    Create as New Brand Type .................................................................................................... 17
Label Information ......................................................................................................................... 20
    View and Submit Request ...................................................................................................... 23
    Print Payment Stub ................................................................................................................ 25
    Submit Payment Stub and Payment ...................................................................................... 27
Identify Label Request .................................................................................................................. 29
    Combination/Gift Pack ........................................................................................................... 29
    Label Information .................................................................................................................. 32
    View and Submit Request ...................................................................................................... 34
    Print Payment Stub ................................................................................................................ 36
    Submit Payment Stub and Payment ...................................................................................... 38
Add New Brand Type for an Existing Brand ................................................................................. 40
    Label Information .................................................................................................................. 42
    View Label Request .............................................................................................................. 44

Published November 15, 2013       Page 2 of 172
Print Payment Stub ................................................................................................................... 46
Submit Payment Stub and Payment .......................................................................................... 48
Revise Label .............................................................................................................................. 50
Label Information ..................................................................................................................... 52
View and Submit Request ......................................................................................................... 54
Print Payment Stub ................................................................................................................... 56
Submit Payment Stub and Payment .......................................................................................... 58
Manage Label Requests ............................................................................................................ 60
View a Label Request ............................................................................................................... 61
Add a Note to a Label Request ................................................................................................. 65
Shopping Cart ............................................................................................................................... 67
Print Payment Stub ................................................................................................................... 68
Submit Payment Stub and Payment .......................................................................................... 70
Importer/Franchise Registration ................................................................................................... 72
Register Brand Owner, Supplier, and Importer for a Malt Beverage, Wine, Cider or Low Alcohol Beverage...................................................................................................................... 72
Add Applicant/Licensee Virginia Importers, Farm Winery, winery, or brewery ..................... 81
Update Wholesaler/Territories .................................................................................................. 86
Designate Military Installations in Territories .......................................................................... 95
Finish and Pay ......................................................................................................................... 101
Register a Négociant Brand Owner, Supplier, and Importer for Wine ................................... 104
Add a Supplier ........................................................................................................................ 111
Add Applicant/Licensee Virginia Wine Importers ..................................................................... 115
Update Wholesaler/Territories ................................................................................................. 120
Designate Military Installations in Territories ........................................................................ 129
Review and Submit ................................................................................................................. 134
Finish and Pay ......................................................................................................................... 137
Manage Account ......................................................................................................................... 140
Payment History ....................................................................................................................... 141
Update Contact Information ................................................................................................... 142
Update Address Information ................................................................................................. 143
INTRODUCTION

The Virginia Department of Alcoholic Beverage Control's Product Registration website provides access to the Product Registration System. The website also provides guidance on creating an account, logging in to Account Central and getting help. If you already have an Account Central account, it is unnecessary to create another account to use the Product Registration application.

ABOUT THE APPLICATION

The Product Registration application provides a way for you to electronically:

- Register labels for wine, malt beverage, cider, and low alcohol beverage products for sale in the Commonwealth of Virginia,
- Register Importers and Franchise Owners of wine, malt beverage, cider and low alcohol beverage products to be sold in the Commonwealth of Virginia,
- Manage your label requests,
- Manage your user account,
- Print payment stubs (Shopping Cart), and
- View Tax Management Web Reports.

Please ensure that pop-up blocker is turned off in your internet browser before you begin the application. To turn off pop-up blocker in Internet Explorer go to Tools > Pop-up Blocker > Turn off Pop-up Blocker.

At the top of the Welcome screen, you will see Help, Feedback, and Logout buttons. Click the Help button to display the Product Registration User Guide. Click the Feedback button to complete the feedback survey for the application and user guide. Click the Logout button to log out of the application.

The Welcome screen features a left navigation bar of menu options. Click any option to select it. The buttons in the center of the screen briefly describe the functions you can perform within each menu option. Click any button to select it.

Do not use the Back button in your Web browser to return to a previous page in the Product Registration application. Many screens in the application have a Previous button that you can click to return to the previous page.

Most fields (data entry points) within the application require you to enter information. If you do not enter information in a required field, you will receive an advisory message. You will not be able to Save until the required data is entered.
You will see the following symbols used consistently throughout the application.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnifying glass</td>
<td>Magnifying glass</td>
<td>View, add, or revise an entry.</td>
</tr>
<tr>
<td>Notepad</td>
<td>Notepad</td>
<td>Add notes and view note history. Notes are optional and are for your convenience.</td>
</tr>
<tr>
<td>Red X</td>
<td>Red X</td>
<td>Delete an entry before you submit a label or franchise registration.</td>
</tr>
</tbody>
</table>

The application is set to “time out” after approximately 30 minutes of inactivity. You will not receive a warning. When the application times out, you will see the message shown below.

If you wish to continue working after the time out, you can log out and log in again immediately. You do not have to contact your system administrator. However, any label or importer/franchise registration applications that were started and not finished will be lost.
ABOUT THE USER GUIDE

This guide contains information and instructions for using the Product Registration application. The guide is a PDF (portable document format) file. The PDF was created in Adobe Acrobat 11. The Adobe Acrobat 11 reader is available as a free download from http://get.adobe.com/reader/.

USERS

Users of the application are Virginia brewers and Virginia wineries, brand owners, brand agents, importers, distributors, négociants, suppliers, wholesalers and compliance agents.

ORGANIZATION

The guide is arranged according to the menu options on the Welcome Screen.

- Label Registration
- Manage Label Requests
- Shopping Cart
- Importer/Franchise Registration
- Manage Accounts

The Table of Contents lists each topic covered in the guide. To go directly to a topic:

• Press Ctrl-click on the page number to follow the link to your topic.

A glossary of most terms used in the application is located at the back of the guide.
NAVIGATION

Use Bookmarks to navigate through the user guide. To display bookmarks in the PDF, double click the PDF to open, then on the menu bar click View>Show/Hide>Navigation Panes>Bookmarks.

Bookmarks will appear on the left side of the screen.

- Click the appropriate bookmark to go to the desired section of the guide.
FEEDBACK

Please let us know if you have questions, comments, or suggestions for the improvement of the Product Registration application or the Product Registration Guide. There are several ways to provide feedback on the application and the guide.

You can:

— Click the Feedback button at the top of the application screen and complete the survey,
— Email your comments to us at productapproval@abc.virginia.gov, or
— Call us at 804-231-4555.
**Note:** If you have established an Account Central account, log in using your Account Central Log in ID and password. If you do not have an Account Central account with Virginia ABC (for example: WebTax) you will need to create an account by clicking the Sign up for an Account Central account link. See [Sign up for an Account Central account](#) in Appendix A for instructions on how to create an Account Central account.

### GETTING STARTED

### LOGGING IN

To log into the Product Registration application:

- Type your Login ID and password.
- Click Login.
The Welcome to Virginia ABC Product Registration screen appears.

The Welcome screen lists menu options in the left navigation panel and provides a brief explanation of each menu item beneath the menu buttons on the center panel.

To select a menu item:

- Click the menu item in the left navigation panel or click a menu button in the center of the screen.
- Click the Help button at the top of the right side of the screen to open the Product Registration User Guide.

  — Label Registration – apply for Brand Registration and Label Approval
  — Manage Label Requests – review the labels you have requested
  — Shopping Cart – submit, print and remit payment for a Label Registration Request
  — Importer/Franchise – register Importers, Brand Owners, VA Wineries/Breweries, Suppliers, Distributors, and Franchise territory information
  — Manage Account – manage your account including password and security questions
  — Tax Management Web Reports- view Tax Management Reports
LABEL REGISTRATION

Click Label Registration to begin the label registration process.

The Label Applicant Search window appears.

LABEL APPLICANT SEARCH

Search for the company trade name of the applicant requesting label registration.

- Click Search Applicant to search for an applicant name or license ID.

The number in the yellow block is a reminder that your shopping cart contains labels for which you must remit payment.

Click Previous to return to the previous screen.

Click Logout to log out of the application.

Click Help to open the Product Registration User Guide.

Click Feedback to complete the feedback survey for the application and the user guide.
The Product Registration search window appears.

- Type a full or partial company trade name, a valid Virginia importer’s license, or a valid ID number in the search field.

**Note:** An ID number is a number assigned by the Virginia ABC to an unlicensed supplier. Numbers beginning with X are assigned to wine suppliers and numbers beginning with B are assigned to beer suppliers.

- Click Search.

A list of companies matching your search criteria will be returned.

**Note:** If you enter a partial company trade name, such as “Nat,” an unalphabetized list of all company trade names containing the letters you entered will be returned. If necessary, use the scroll bar on the right side of the screen to scroll down and locate the name you need.

If the applicant you searched for is listed,

- Double-click the applicant name.

Go to the first page of the list.

Go to the previous page.

Go to the next page

Go to the last page of the list.

Use the scroll bar to scroll to the correct company.
The applicant/company trade name, license number, and address appear in Applicant Information.

- Click Next to search for a brand name. (See Brand Name Search.)

If the company or trade name you searched for is not found,
- Click Enter New Applicant. (See Enter Applicant Information.)

Note: If the search does not return the results you are expecting, please see Appendix E: Product Registration Search Functionality for help in completing a successful search.
ENTER APPLICANT INFORMATION

If the applicant’s name was not found in the search list,

- Type the company trade name of the new applicant.
- Type the applicant’s address.
- Click Next to save applicant information and open the Brand Name Search window.

The Brand Name Search window appears.

BRAND NAME SEARCH

Search for the brand name of the label you want to register.

In the search field,

- Type the brand name of the label you want to register.
- Click Search Brand.
A list of brands matching your search criteria is returned.

**Note:** If you enter a partial brand name, such as “Dog,” an unalphabetized list of all names containing that group of letters will be returned. Use the scroll bar to locate the correct name.

When the correct name is located,
- Double click the name to select it.

**Note:** If you would like to expand or narrow your search, click the Modify Search button to change the search criteria. The Search field will clear and you can enter new search criteria.

If the exact brand name is found, see [Identify Label Request](#).
If the brand name is not found in the search list,

- Click Create as New Brand Type.

The Edit Brand Type screen appears.

**CREATE AS NEW BRAND TYPE**

The application created the brand name from the name you entered in Brand Name Search. You will add new brand type.

- Click Add New Brand Type.

Click Cancel at any time to cancel your label application request.
The Edit Brand Type screen appears.

**Note:** Select Combination/Gift Pack only if this brand type is in a combination/gift pack to be submitted for approval.

- Type brand type details including the varietal.
- Type a (V) for vintage or (NV) for non-vintage.
- Select Place of Origin from the drop-down list.
- Click Save Details.
Brand type details are saved, the screen refreshes and the new brand type appears in the Brand Types table.

- Click Add Label Information for Selected Brand Type.

Click the magnifying glass to view or edit brand type information.
Click the X to remove the brand type entry.
The Label Information window appears.

**LABEL INFORMATION**

Add label information for this brand type.

1. Type the label description.
2. Select approval type from the drop-down list. Approval types are: cider, low alcohol beverage, malt beverage, or wine.
3. Type alcohol by volume percentage.
4. Type a TTB (Alcohol and Tobacco Tax and Trade Bureau) ID or attach a TTB image. (See TTB ID notes below.)
5. Attach a label image.
6. Click Save.

**Label Notes:**

- Label description is a required field for your use in identifying labels by graphics, vintage, and size.
- The label image must be a JPEG (Joint Photographic Experts Group).
- See [Appendix C: How to Scan your Labels for Readability](#) to ensure your label scan is usable.
- Links to View Notes, View TTB and View Label are active after you click Save.

**TTB ID Notes:**

- If you receive an advisory message indicating that the TTB is not available the first time you enter the TTB ID, try again.
- The TTB image must be a PDF. If the TTB is multiple pages, all pages must be in one PDF file.
- The TTB image will not contain a TTB ID number because the TTB online COLA (Certificates of Label Approval) is not available on the TTB COLA Registry until three days after federal approval.
Caution: You will receive an advisory message if you enter information incorrectly or if you fail to enter information in a required field on the Label Information window. The message on the screen below is an example of the advisory message you will see if you enter a TTB ID that is not on file or you enter the ID incorrectly.
Note: If you add more than one brand type, you must add a label for each brand type.

Caution: Make sure you have added all brand types and labels for this application before you leave this screen. If you leave this screen without adding all information, you will lose everything entered and you will not be able to retrieve the information.

When you have added all brand types and labels,

- Click Continue at the bottom of the Edit Brand Type screen to view your request.

Click the magnifying glass to see label information.

Click the note pad to add or view notes about the label. Notes are not required.

Click the red X to remove label information.

Click Continue to view your request.
The View Request screen appears.

**VIEW AND SUBMIT REQUEST**

- View your label request to ensure that all information is correct.
- Click View in separate window to view full screen.

**Note:** Close full screen view before attempting to submit your request.

If you want to change a label request:
- Click Previous to return to the previous screen and make required changes.

If all information is correct:
- Click Submit Request.
The Submit Request – Complete screen appears.

At the Submit Request – Complete screen you can:

— Select Add More Labels to return to Label Registration.
— Select Finish & Pay to print your payment stub.
— Select Add Franchise to go to Importer/Franchise Registration.

Notes:

— If you do not have franchise information on file you will see the following submit Request - Complete screen. The message in blue advises you to add franchise information.
— If you register a new label and add a franchise for the label without adding the label registration applicant as either the supplier or importer in franchise registration, you might see the following screen when you return to Product Registration to register more labels. If you see this screen, go to Shopping Cart to pay for your labels. You do not need to register the franchise again.

Caution: The following screens contain important information about your label request, fee, and payment. Please read the information carefully.
The Print Payment Stub screen appears.

**Note:** The procedures for printing your payment stub and mailing the payment stub along with your payment to Tax Management are the same for all label registrations. Therefore, the information printed on pages 25, 26, 27 and 28 will be repeated on pages 36, 37, 38 and 39, and on pages 46, 47, 48 and 49, as well as 56, 57, 58 and 59, and 68, 69, 70, and 71.

---

**PRINT PAYMENT STUB**

**Caution:** Please ensure that pop-up blocker is turned off in your internet browser before you attempt to print the payment stub. To turn off pop-up blocker in Internet Explorer go to Tools > Pop-up Blocker > Turn off Pop-up Blocker.

- Select the applicant from the drop-down list.

**Note:** You must select an applicant before you have the option to print.

---

The total number of labels for which you must remit payment appears beside the shopping cart menu option on the left navigation panel on the Product Registration Welcome screen.
The print Payment Stub screen appears showing the labels pending for the applicant you selected.

**Notes:**
- If you want to print all labels, click the box beneath All. The payment stub will show the total due for each beverage type, followed by the total due for all beverage types.
- If you want to print specific labels, click the check box beside each label you want to print. The payment stub will show the total due for each beverage type followed by the total due for all beverage types.
- When you click Print Payment Stub, this label application is closed. You can no longer make changes to the labels submitted or add labels to this request.

If you want to print all labels:
- Click the check box beneath All.

If you want to print specific labels:
- Click the check box beside each label you want to print.
- Click Print Payment Stub.
Submit Payment Stub and Payment

- Print two copies of the payment stub (one for your files and one to send with your payment to Tax Management).
- Choose the appropriate address to mail or overnight your payment stub along with your payment. If you do not have franchise information on file, you are required to submit franchise information online or mail your franchise information with your payment stub and payment.

---

<table>
<thead>
<tr>
<th>Request Date</th>
<th>Approval Type</th>
<th>Brand</th>
<th>Brand Type</th>
<th>Label Description</th>
<th>Amount</th>
<th>Franchise on File</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/01/2013</td>
<td>Matt Beverage</td>
<td>Twisted Tea Brewing Company</td>
<td>Light Hand-Kissed Tea, 12 fl. oz. 12-pack</td>
<td>Select Tank Natural Flavors Alcoholic Beverages</td>
<td>$30.00</td>
<td><strong>No</strong></td>
</tr>
</tbody>
</table>

Total Wire Transfer Due: $0.00
Total Beer Amount Due: $30.00
Total Due: $30.00

---

*Your franchise information is currently on file for this brand. You are not required to submit this information again if you are not making any changes. If changes are being made, please submit with this form.*

*Your company does not have franchise information on file for this brand, please submit your franchise information with this form.*

The fee is non-refundable and non-transferable. However, if the label cannot be approved due to incorrect data or missing information the application is held open for 12 months to allow the applicant to submit the required information. If the information is not received after the 12 months the application is discontinued without any further notice.

---

Mail to: VIRGINIA ABC BOARD
         PO BOX 27491
         RICHMOND VA 23261

Overnight to: VIRGINIA ABC BOARD
              2901 HERITAGE ROAD
              RICHMOND VA 23220
The Print Payment Stub screen appears with a notation that the payment was made successfully.

![Print Payment Stub]

A cashier at the Virginia ABC receives your payment stub and check and creates a receipt. The cashier then sends the receipt to Tax Management with your payment stub. Tax Management processes your application and sends you an email advising that your label has been approved and giving you the approval code number.

Once the label is processed the label information will be available on the Tax Management Website the next day.
IDENTIFY LABEL REQUEST

Identify Label Request allows you to add a new label for an existing brand or revise an existing label.

Appendix B: Existing Brands – New Label or Revised Label? contains a table to guide you in determining whether to create a new label or revise an existing label.

If you are registering a new label for:

A Combination/Gift Pack, see Combination/Gift Pack below.

A new Brand Type such as a new varietal or special edition, see Add New Brand Type for an Existing Brand.

If you are revising a label to make a change to an existing label such as changing a graphic image, changing vintage or changing size, see Revise Label.

COMBINATION/GIFT PACK

- Click New Label to register a label for a combination/gift pack.

Appendix D: Requirements for Combination Packages and Gift Packages Approval contains additional information for properly registering a combination/gift pack.
The Edit Brand Type screen appears.

- Type Brand Type details such as variety pack.
- Click Combination/Gift Pack.
- Click Save Details.

When you select Combination/Gift Pack, Place of Origin is not required.
Brand Type information is saved, the Edit Brand Type screen refreshes and the new Brand Type information is added to the Brand Types table at the bottom of the Edit Brand Type screen.

- Click Add Label Information for Selected Brand Type.

Click the magnifying glass to view or edit brand type information.

Click the X to remove brand type information.
The Label Information window appears.

**LABEL INFORMATION**

Include the following information for the Combination/Gift Pack label:

1. Type the combination pack description.
2. Select the approval type from the drop-down list. Approval types are: cider, low alcohol beverage, malt beverage, or wine.
3. Attach the label image.
4. Type the quantity and product approval code for all alcoholic beverages to be included in the package.
5. Type the product quantity and description of all non-alcoholic products to be included in the package. This should include any items to be included in the combination/gift pack including wine glasses, beverage opener, or food.
6. Click Save.
7. Click Continue to return to the Edit Brand Type screen.

**Label Notes:**

— Label description is a required field for your use in identifying this combination/gift pack.
— The label image must be a JPEG.
— See [Appendix C: How to Scan your Labels to Ensure Readability](#) to ensure your label scan is usable.
— Links to View Notes, and View Label are active after you click Save.
Label information is saved and appears in the Labels table on the Edit Brand Type screen.

The Edit Brand Type screen appears.

- Click Continue at the bottom of the Edit Brand Type screen to view your label request.

Click the magnifying glass to view or edit label information.

Click the note pad to add or view label notes.

Click the X to remove the label entry.

Click Continue to view your request.
The View Request screen appears.

**VIEW AND SUBMIT REQUEST**

- View your label request to ensure that all information is correct.
- Click View in separate window to view full screen.

**Note:** Close full screen view before attempting to submit your request.

If you want to change a label request,

- Click Previous to return to the previous screen and make required changes.

If all information is correct,

- Click Submit Request.
The Submit Request – Complete screen appears.

At the Submit Request – Complete screen appears screen you can:

- Select Add more labels to return to Label Registration.
- Select Finish and Pay to print the Payment Stub.
- Select Add Franchise to go to Importer/Franchise Registration.

If you don’t have labels to add and franchise information for your company is on file,

- Click Finish and Pay.

Notes:

- If you do not have franchise information on file you will see the following submit Request - Complete screen. The message in blue advises you to add franchise information.
- If you register a new label and add a franchise for the label without adding the label registration applicant as either the supplier or importer in franchise registration, you might see the following screen when you return to Product Registration to register more labels. If you see this screen, go to Shopping Cart to pay for your labels. You do not need to register the franchise again.

Caution: The following screens contain important information about your label request, fee, and payment. Please read the information carefully.
The Print Payment Stub screen appears.

**Note:** The procedures for printing your payment stub and mailing the payment stub along with your payment to Tax Management are the same for all label registrations. These pages are for reference only.

**PRINT PAYMENT STUB**

**Caution:** Please ensure that pop-up blocker is turned off in your internet browser before you attempt to print the payment stub. To turn off pop-up blocker in Internet Explorer go to Tools > Pop-up Blocker > Turn off Pop-up Blocker.

- Select the applicant from the drop-down list.

**Note:** You must select an applicant before you have the option to print.

The total number of labels for which you must remit payment appears beside the shopping cart menu option on the left navigation panel on the Product Registration Welcome screen.
The print Payment Stub screen appears showing the labels pending for the applicant you selected.

**Notes:**

— If you want to print all labels, click the check box beneath All. The payment stub will show the total due for each beverage type, followed by the total due for all beverage types.

— If you want to print specific labels, click the check box beside each label you want to print. The payment stub will show the total due for each beverage type followed by the total due for all beverage types.

— When you click Print Payment Stub, this label application is closed. You can no longer make changes to the labels submitted or add labels to this request.

If you want to print all labels:

- Click the check box beneath All.

If you want to print specific labels:

- Click the check box beside each label you want to print.
- Click Print Payment Stub.
SUBMIT PAYMENT STUB AND PAYMENT

- Print two copies of the payment stub (one for your files and one to send with your payment to Tax Management).
- Choose the appropriate address to mail or overnight your payment stub along with your payment. If you do not have franchise information on file, you are required to submit your franchise information online or mail your franchise information with your payment stub and payment.
The Print Payment Stub screen appears with a notation that the Payment was made successfully.

A cashier at the Virginia ABC receives your payment stub and check and creates a receipt. The cashier then sends the receipt to Tax Management with your payment stub. Tax Management processes your application and sends you an email advising that your label has been approved and giving you the approval code number.

Once the label is processed the label information will be available on the Tax Management Website the next day.
ADD NEW BRAND TYPE FOR AN EXISTING BRAND

At the Identify Label Request screen:

- Click New Label to register a new label for this brand.

The Edit Brand Type screen appears.

- Type Brand Type details including the varietal.
- Select Place of Origin from the drop-down list.

Note: Place of Origin specifies the state or country where the wine is produced.

After the brand type description,

- Type a (V) for vintage or (NV) for non-vintage.
- Click Save Details.
Brand Type information is saved, the Edit Brand Type screen refreshes and the new Brand Type information is added to the Brand Types table.

- Click Add Information for Selected Brand Type.

Click the magnifying glass to view or edit brand type information.

Click the X to remove the brand type entry.
The Label Information window appears.

**LABEL INFORMATION**

Include the following information for the new brand type.

1. Type the label description.
2. Select approval type from the drop-down list. Approval types are: cider, low alcohol beverage, malt beverage, or wine.
3. Type alcohol by volume percentage.
4. Type a TTB ID or attach a TTB image. (See TTB ID notes below.)
5. Attach a label image.
6. Click Save.
7. Click Continue to return to the Edit Brand Type screen.

---

**Label Notes:**

- Label description is a required field for your use in identifying labels by graphics, vintage, and size.
- The label image must be a JPEG.
- See Appendix C: How to Scan your Labels for Readability to ensure your label scan is usable.
- Links to View Notes, View TTB and View Label are active after you click Save.
- **TTB ID Notes:**
  - If you receive an advisory message indicating that the TTB is not available the first time you enter the TTB ID, try again.
  - The TTB image must be a PDF. If the TTB is multiple pages, all pages must be in one PDF file.
  - The TTB image will not contain a TTB ID number because the TTB online COLA is not available on the TTB COLA Registry until three days after federal approval.
The Edit Brand Type Screen appears.

**Note:** If you add more than one brand type, you must add a label for each brand type.

**Caution:** Make sure you have added all brand types and labels for this application before you leave this screen. If you leave this screen without adding all information, you will lose everything entered and you will not be able to retrieve the information.

When you have added all brand types and labels:
- Click Continue at the bottom of the page to view your request.
The View Label Request Screen appears.

**VIEW LABEL REQUEST**

- View your label request to ensure that all information is correct.
- Click View in separate window to view full screen.

**Note:** Close full screen view before attempting to submit your request.

If you want to change a label request,

- Click Previous to return to the previous screen and make the required changes.

If all information is correct,

- Click Submit Request.
The Submit Request – Complete screen appears.

At the Submit Request – Complete screen appears screen you can:

— Select Add more labels to return to Label Registration.
— Select Finish and Pay to print the Payment Stub.
— Select Add Franchise to go to Importer/Franchise Registration.

Notes:

— If you do not have franchise information on file you will see the following Submit Request – Complete screen. The message in blue advises you to add franchise information.

— If you register a new label and add a franchise for the label without adding the label registration applicant as either the supplier or importer in franchise registration, you might see the following screen when you return to Product Registration to register more labels. If you see this screen, go to Shopping Cart to pay for your labels. You do not need to register the franchise again.

Caution: The following screens contain important information about your label request, fee, and payment. Please read the information carefully.
The Print Payment Stub screen appears.

**Note:** The procedures for printing your payment stub and mailing the payment stub along with your payment to Tax Management are the same for all label registrations. These pages are for reference only.

### PRINT PAYMENT STUB

**Caution:** Please ensure that pop-up blocker is turned off in your internet browser before you attempt to print the payment stub. To turn off pop-up blocker in Internet Explorer go to Tools > Pop-up Blocker > Turn off Pop-up Blocker.

- Select the applicant from the drop down list.

**Note:** You must select an applicant before you have the option to print.

The total number of labels for which you must remit payment appears beside the shopping cart menu option on the left navigation panel on the Product Registration Welcome screen.
The print Payment Stub screen appears showing the labels pending for the applicant you selected.

Notes:

— If you want to print all labels, click the check box beneath All. The payment stub will show the total due for each beverage type, followed by the total due for all beverage types.
— If you want to print specific labels, click the check box beside each label you want to print. The payment stub will show the total due for each beverage type followed by the total due for all beverage types.
— When you click Print Payment Stub, this label application is closed. You can no longer make changes to the labels submitted or add labels to this request.

If you want to print all labels:

• Click the check box beneath All.

If you want to print specific labels:

• Click the check box beside each label you want to print.
• Click Print Payment Stub.
Submit Payment Stub and Payment

- Print two copies of the payment stub (one for your files and one to send with your payment to Tax Management).
- Choose the appropriate address to mail or overnight your payment stub along with your payment. If you do not have franchise information on file, you are required to submit your franchise information online or mail your franchise information with your payment stub and payment.

![Payment Stub Image]
The Print Payment Stub screen appears with a notation that the payment was made successfully.

A cashier at the Virginia ABC receives your payment stub and check and creates a receipt. The cashier then sends the receipt to Tax Management with your payment stub. Tax Management processes your application and sends you an email advising that your label has been approved and giving you the approval code number.

Once the label is processed the label information will be available on the Tax Management Website the next day.
REVISE LABEL

Note: You can only revise the label of an approved brand type.

At the the Identify Label Request screen,

- Click Revise Label.

The Brand Type Search window appears.

- Click the magnifying glass beside the Brand Type label you want to revise.
The Brand Type Search window appears.

The Brand Type you selected appears at the top of the screen.

- Click Add Label Information for Selected Brand Type to add information for the new label.

Selected Brand Type details cannot be changed.
The Label Information window appears.

**LABEL INFORMATION**

1. Type the new label description.
2. Select the approval type from the drop-down list. Approval types are: cider, low alcohol beverage, malt beverage, or wine.
3. Type the alcohol by volume percentage.
4. Type the TTB ID or attach a TTB image. (See TTB ID notes below.)
5. Attach a label image.
6. Click Save.
7. Click Continue to return to the Brand Type Search screen.

---

**Label Notes:**

— Label description is a required field for your use in identifying labels by graphics, vintage, and size.
— The label image must be a JPEG.
— See Appendix C: How to Scan your Labels for Readability to ensure your label scan is usable.
— Links to View TTB and View Label are active after you click Save.

---

**TTB ID Notes:**

— If you receive an advisory message indicating that the TTB is not available the first time you enter the TTB ID, try again.
— The TTB image must be a PDF. If the TTB is multiple pages, all pages must be in one PDF file.
— The TTB image will not contain a TTB ID number because the TTB online COLA is not available on the TTB COLA Registry until three days after federal approval.
The Brand Type Search window appears

Revised label information has been added to the Labels table in status “Created.”

- Click Continue at the bottom of the page to view your label request

Click the magnifying glass to view the label information.

Click the note pad to view or add notes.

Click the X to remove the label entry.
The View and Submit screen appears.

**VIEW AND SUBMIT REQUEST**

- View your label request to ensure that all information is correct.
- If you want to change a label request,
  - Click the Previous button to return to the previous screen to make the required changes.
- If all information is correct,
  - Click Submit Request

![View Request Screen](image)
The Submit Request – Complete screen appears.

At the Submit Request – Complete screen you can:

- Select Add more labels to return to Label Registration.
- Select Finish and Pay to print the Payment Stub
- Select Add Franchise to go to Importer/Franchise Registration.

If you do not have labels to add and your franchise information is on file,

- Click Finish and Pay.

Notes:

- If you do not have franchise information on file you will see the following Submit Request – Complete screen. The message in blue advises you to add franchise information.
- If you register a new label and add a franchise for the label without adding the label registration applicant as either the supplier or importer in franchise registration, you might see the following screen when you return to Product Registration to register more labels. If you see this screen, go to Shopping Cart to pay for your labels. You do not need to register the franchise again.

Caution: The following screens contain important information about your label request, fee, and payment. Please read the information carefully.
The Print Payment Stub screen appears.

Note: The procedures for printing your payment stub and mailing the payment stub along with your payment to Tax Management are the same for all label registrations. These pages are for reference only.

**PRINT PAYMENT STUB**

**Caution:** Please ensure that pop-up blocker is turned off in your internet browser before you attempt to print the payment stub. To turn off pop-up blocker in Internet Explorer go to Tools > Pop-up Blocker > Turn off Pop-up Blocker.

- Select the applicant from the drop-down list.

Note: You must select an applicant before you have the option to print.
The print Payment Stub screen appears showing the labels pending for the applicant you selected.

Notes:

— If you want to print all labels, click the check box beneath All. The payment stub will show the total due for each beverage type, followed by the total due for all beverage types.
— If you want to print specific labels, click the check box beside each label you want to print. The payment stub will show the total due for each beverage type followed by the total due for all beverage types.
— When you click Print Payment Stub, this label application is closed. You can no longer make changes to the labels submitted or add labels to this request.

If you want to print all labels:

• Click the check box beneath All.

If you want to print specific labels:

• Click the check box beside each label you want to print.
• Click Print Payment Stub.
SUBMIT PAYMENT STUB AND PAYMENT

- Be sure to print two copies of the payment stub (one for your files and one to send with your payment to Tax Management).
- Choose the appropriate address to mail or overnight your payment stub along with your payment. If you do not have franchise information on file, you are required to submit your franchise information online or mail your franchise information with your payment stub and payment.

![Image of payment stub and payment form]

> Commonwealth of Virginia
> Department of Alcoholic Beverage Control
> Label Approval Request

Transaction Id: 7485

****** Payment Stub ******

Please print & mail a copy of this report to one of the below addresses along with your payment.

<table>
<thead>
<tr>
<th>Account</th>
<th>Applicant</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reason Beer Corp</td>
</tr>
<tr>
<td></td>
<td>1 Design Center Pl Ste 650</td>
</tr>
<tr>
<td></td>
<td>Boston MA 0221062300</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Request Date</th>
<th>Approval Type</th>
<th>Brand</th>
<th>Brand Type</th>
<th>Label Description</th>
<th>Amount</th>
<th>Franchise on File</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/05/2013</td>
<td>Mail Bowenho</td>
<td>Twisted Tree Brewing Company</td>
<td>Light Hard Iced Tea</td>
<td>Helles Vienna Natural</td>
<td>$30.00</td>
<td>***NO</td>
</tr>
</tbody>
</table>

Total Beer Amount Due: $30.00
Total Beer Amount Due: $30.00
Total Due: $30.00

**Your Franchise Information is currently on file for this brand. You are not required to submit this information again if you are not making any changes. If changes are being made, please submit with this form.**

**Your company does not have Franchise Information on file for this brand, please submit your Franchise Information with this form.**

The fee is non-refundable and non-transferable. However, if the label cannot be approved due to incorrect data or missing information the application is held open for 12 months to allow the applicant to submit the required information. If the information is not received after the 12 months the application is disapproved without any further notice.

Mail to: VIRGINIA ABC BOARD
        TAX MANAGEMENT SECTION
        PO BOX 27481
        RICHMOND VA 23281

Overnight to: VIRGINIA ABC BOARD
              TAX MANAGEMENT SECTION
              2301 VINTAGE ROAD
              RICHMOND VA 23220
The Print Payment Stub appears with a notation that the Payment was made successfully.

A cashier at the Virginia ABC receives your payment stub and check and creates a receipt. The cashier then sends the receipt to Tax Management with your payment stub. Tax Management processes your application and sends you an email advising that your label has been approved and giving you the approval code number.

Once the label is processed the label information will be available on the Tax Management Website the next day.
MANAGE LABEL REQUESTS

Manage Label Requests allows you to view the current status and details about your label requests submitted to VA ABC. You can view label requests and remove or cancel a label request before approval, and add or view notes before you click Print Payment Stub.

To access and manage your label requests, click Manage Label Requests at the Welcome screen.

The Manage Label Requests screen appears. The screen will show your requests for a specific date range.

The number in the yellow block is a reminder that your shopping cart contains labels for which you must remit payment.

Click Logout to log out of the application.

Click Feedback to complete the feedback survey for the application and the user guide.

Click Help to open the Product Registration User Guide.

Click the magnifying glass to view a label request.

Click the X to delete a label request.

Click the note pad to add or view notes.
VIEW A LABEL REQUEST

You can filter or sort your label requests by Transaction ID, Brand Name, Status or From/To (date range). All or multiple filters may be used simultaneously.

To filter requests by Transaction ID:

- Type Transaction ID in the Transaction ID field
- Click Filter

A Request filtered on Transaction ID will return a list containing the item that matches the Transaction ID.
To filter requests by Brand Name:

- Type Brand Name in the Brand Name field.
- Click Filter.

A Request filtered by Brand Name will return a list of items matching the Brand Name.
To filter requests by Status:

- Select Status from the drop-down list. Status includes: all requests, requests created, pending payment, pending approval, approved, delisted, deleted, disapproved or unknown.
- Click Filter.

A Request filtered by Status will return a list of items matching the Status filter you selected.
To filter requests by Date:

- Click in the From or To field and type new dates.
- Click Filter.

A list of requests processed on dates you entered appears.

If you change the date range and there are no requests matching the date range you entered, there will be no items listed and you will receive an advisory message.

**Note:** You will receive an advisory message if there are more than 50 requests matching your search criteria. If you receive this message, please choose multiple filters to narrow your search.
ADD A NOTE TO A LABEL REQUEST

• Click the note pad icon to add a note to a label request.

The note screen appears.

• Type the note text.
• Click Add.
The note is saved and appears in Note History at the bottom of the screen. Once notes are saved they cannot be changed.
SHOPPING CART

At Shopping Cart you can print the payment stub and submit payment stub and payment for a label registration request.

To access the Shopping Cart, click Shopping Cart at the Welcome screen,
**Note:** The procedures for printing your payment stub and mailing the payment stub along with your payment to Tax Management are the same for all label registrations. These pages are for reference only.

**PRINT PAYMENT STUB**

**Caution:** Please ensure that pop-up blocker is turned off in your internet browser before you attempt to print the payment stub. To turn off pop-up blocker in Internet Explorer go to Tools > Pop-up Blocker > Turn off Pop-up Blocker.

The print Payment Stub screen appears showing labels pending for all applicants.

- Select the applicant from the drop-down list.

**Note:** you must select an applicant before you have the option to print.

The total number of labels for which you must remit payment appears beside the shopping cart menu option on the left navigation panel on the Product Registration Welcome screen.
The Print Payment Stub refreshes showing the labels pending for the applicant you selected.

**Notes:**

— If you want to print all labels, click the check box beneath All. The payment stub will show the total due for each beverage type, followed by the total due for all beverage types.

— If you want to print specific labels, click the check box beside each label you want to print. The payment stub will show the total due for each beverage type followed by the total due for all beverage types.

— When you click Print Payment Stub, this label application is closed. You can no longer make changes to the labels submitted or add labels to this request.

If you want to print all labels:

- Click the check box beneath All.

If you want to print specific labels:

- Click the check box beside each label you want to print.
- Click Print Payment Stub.
Submit Payment Stub and Payment

- Print two copies of the payment stub (one for your files and one to send with your payment to Tax Management).
- Choose the appropriate address to mail or overnight your payment stub along with your payment. If you do not have franchise information on file, you are required to submit your franchise information online or mail your franchise information with your payment stub and payment.
The Print Payment Stub screen appears with a notation that the payment was made successfully.

![Print Payment Stub]

A cashier at the Virginia ABC receives your payment stub and check and creates a receipt. The cashier then sends the receipt to Tax Management with your payment stub. Tax Management processes your application and sends you an email advising that your label has been approved and giving you the approval code number.

Once the label is processed the label information will be available on the Tax Management Website the next day.
IMPORTER/FRANCHISE REGISTRATION

REGISTER BRAND OWNER, SUPPLIER, AND IMPORTER FOR A MALT BEVERAGE, WINE, CIDER OR LOW ALCOHOL BEVERAGE

At the Welcome screen, click Importer/Franchise Registration

Each Virginia applicant/licensee must secure a completed and signed Brand Owner’s Written Authorization to Importer Letter before beginning the Importer/Franchise registration process, if a Brand Owner’s Written Authorization to Importer Letter is required.

A Brand Owner’s Written Authorization to Importer Letter is not required if the brand owner and applicant are the same, or if the brand owner is a Virginia Winery, Farm Winery, or Brewery.
If you have registered a new or revised label on or after August 1, 2013 through the online system, the brand should appear in the list of Franchise Requests. You can add new franchise information, update an existing franchise, or add wholesalers and territories. If the brand does not appear in the list, initiate a brand search.

**Note:** If you search for a brand that is already in the Franchise Requests list you will receive an advisory message similar to the following:

If the brand/franchise you wish to add or update is listed,

- Click the radio button beside the name to select the brand.
- Click the appropriate button at the bottom of the screen to add or update a franchise, add a négociant brand owner, or update wholesalers/territories.

**Notes:**

— If the brand name is listed more than once, make sure you select the correct product type for the brand.
— If the brand you searched for is a new brand, it will appear at the bottom of the Franchise Requests list.
— If the brand you searched for is an existing brand, it will be listed alphabetically.
The Importer/Franchise Registration screen appears. At this screen you can add brand owner/négociant brand owners, and add or remove:

- suppliers,
- applicants/licensees

You can also download a blank Brand Owner’s Written Authorization to Importer Letter. The Brand Owner’s Written Authorization to Importer Letter must be completed and signed by the brand owner before you can proceed with the franchise registration, if the brand owner’s written authorization is required.

A Brand Owner’s Written Authorization to Importer Letter is not required if the brand owner and applicant are the same, or if the brand owner is a Virginia Winery, Farm Winery, or Brewery.

**Note:** When you obtain the completed and signed Brand Owner’s Written Authorization to Importer Letter, save the completed and signed form as a PDF so you can upload the form to the applicant/licensee registration at the appropriate time.

- Type the brand owner’s name.
- Click Add.

**Notes:**

- You must add the brand owner before you can add the supplier.
- Each brand owner is considered a separate franchise. For one brand there can be only one brand owner.
The Product Registration search window appears listing the brand owners who match your search criteria.

- Double-click the name to select the brand owner.

If the search result does not include the name you entered,
- Click Enter as New Brand Owner, or
- Initiate a new search.

**Note:** If the search does not return the results you are expecting, please see Appendix E: Product Registration Search Functionality for help in completing a successful search.

The Importer/Franchise Registration screen appears. Brand Owner has been added to the Affiliation table.

**Note:** Once the franchise registration is submitted, you can no longer change or edit the brand owner’s name. After the registration is submitted, send any changes to the brand owner’s name to Tax Management for updating.

If you want to change the Brand Owner before submitting the franchise registration,
- Type the new name in the search field.
- Click Search.

When the search result appears,
- Double-click the name to select the brand owner.

The new entry will overwrite the current entry.

You may also delete the brand owner and add a new one.
ADD A SUPPLIER

- Click the radio button to specify whether the brand owner and the supplier are the same.

If you click “Yes” to specify that the brand owner and the supplier are the same, the brand owner will be added to the Affiliation table as supplier.
If you click “No” to specify that the brand owner and the supplier are not the same, a search field is opened on the screen so you can search for and add a supplier.

**Note:** Each franchise must have at least one supplier.

- Type the full or partial name of the supplier in the Search field.
- Click Add.

**Notes:**
- You can add more than one supplier.
- You must specify whether the brand owner and supplier are the same for each supplier added.
The Product Registration search window appears listing the suppliers who match your search criteria. You can choose a supplier from the supplier’s listed or you can enter the name of a new supplier.

If the supplier is not listed,

- Click Enter as New Supplier,
- or
- Type a different name.
- Click Search.

**Note:** If the search does not return the results you are expecting, please see Appendix E: Product Registration Search Functionality for help in completing a successful search.

If the supplier is listed,

- Double-click the name to select the supplier.
The Importer/Franchise screen appears. The supplier is listed in the Affiliation table.

Click X to remove the supplier.
To add a second supplier,

- Repeat the steps to Add a Supplier beginning on page 76.
- Repeat the process to add another supplier.

Each new supplier will be added to the Affiliation table.
ADD APPLICANT/LICENSEE VIRGINIA IMPORTERS, FARM WINERY, WINERY, OR BREWERY

Each Virginia applicant/licensee must secure a completed and signed Brand Owner’s Written Authorization to Importer Letter before beginning the Importer/Franchise registration process, if a Brand Owner’s Written Authorization to Importer Letter is required.

A Brand Owner’s Written Authorization to Importer Letter is not required if the brand owner and applicant are the same, or if the brand owner is a Virginia Winery, Farm Winery, or Brewery.

Note: When you obtain the completed and signed Brand Owner’s Written Authorization to Importer Letter, save the completed and signed form as a PDF so you can upload the form to the applicant/licensee registration at the appropriate time.

- Type the applicant’s license number in the search field.
- Click Add

Note: You can add more than one applicant/licensee.
The product Registration search window appears listing the applicants who match your search criteria.

Double-click the name to select the applicant.

Note: If the search does not return the results you are expecting, please see Appendix E: Product Registration Search Functionality for help in completing a successful search.
The Importer/Franchise Registration screen appears. The applicant/licensee has been added to the table at the bottom of the screen.

Click the applicant number to view the importer's information.

Click the X to remove the applicant/licensee.

Importer Information displayed when you click the applicant number.
If the Brand Owner’s Written Authorization is required for the applicant/licensee, a field opens that allows you to browse for and upload the completed form.

- Click Browse to locate the signed Brand Owner’s Written Authorization.

When the authorization is located,

- Click Upload to save the authorization to this application.

**Caution:** If you do not click Upload, the authorization will not be saved to the franchise registration.

**Note:** If the Brand Owner’s Written Authorization is required, you must upload the authorization:

- for each applicant/licensee you add, unless the brand owner and applicant/licensee are the same;
- before you can update wholesalers/territories; and
- before you review and submit your registration.
The Importer/Franchise screen refreshes. The Brand Owner’s Written Authorization has been added to the table at the bottom of the screen beside applicant/licensee. Click the magnifying glass on the right side of the table to view the authorization.

To add applicant/licensees,

- Repeat the steps to Add Applicant/Licensee beginning on page 80 for each additional applicant/licensee.

If you want to update wholesaler/Territories,

- Click **Update Wholesaler/Territories**.

If you do not want to update wholesaler/territories but you want to submit your franchise request,

- Click **Review and Submit** to update supplier and applicant/licensee.
UPDATE WHOLESALER/TERRITORIES

You may add wholesalers at two points in the application: to an existing brand from the Franchise Requests list, or as part of the franchise registration process.

Caution: You cannot delete a wholesaler or his territories after the franchise registration has been submitted. You may add counties or independent cities if the counties or cities have not been assigned to another wholesaler. If you wish to remove a wholesaler or territory, you will need to obtain a release letter from the wholesaler to whom the territory is currently assigned. Or the territory can be deleted in accordance with 4.1.407 (wine) or 5.1-506 (malt beverage) of the Code of Virginia.

To add wholesaler/territories to an existing brand,

- Click the radio button beside the brand name to select it.
- Click the Wholesaler/Territory button at the bottom of the Importer/Franchise Registration screen.
To update wholesaler/territories while adding/updating a franchise,

- Click Update Wholesaler/Territories at the Importer/Franchise Registration screen after you add applicant/licensees.
The Franchise Distributors window appears.

**Notes:**

— If a wholesaler of a brand/product type has the entire state assigned, no other wholesaler can be assigned. If this condition exists, search functionality will not be available.
— If a wholesaler has been assigned certain territories for a brand/product type, the assigned territories cannot be assigned to a different wholesaler. The assigned territories will be “grayed” out.

**Caution:** Two distributors cannot be assigned the same or overlapping territories for a specific brand. Check territory availability for your brand on the Tax Management Web Reports website in Franchise Brands by Distributor Detail.

![Franchise Distributors](image)

- Type the name or license ID for the wholesaler you are authorizing.
- Click Search.

The Product Registration search window appears listing the wholesalers who match your search criteria.

- Double-click the name to select the wholesaler.
Caution: You must enter a license ID that is relevant to the product type. If you are adding a franchise for a malt beverage, you must enter a license ID for a malt beverage product type. If you enter a license ID for a different product type, such as wine, you will receive an advisory message similar to the message shown on the screen below.

Note: You can obtain the correct wholesaler license number by contacting the Virginia ABC Tax Management office in Richmond, or by accessing Tax Management Web Reports. At the Web Reports screen, click Suppliers, Importers, Retailers to display the Report Type screen. Click the arrow to display the drop-down list. Select Importer – In-State or Importer – Out-of-State for the specific product type. Click Submit. A list of in-state or out-of-state importers appears.

The Franchise Distributors screen appears. The wholesaler you selected has been added to the Results table.

Note: You may add several wholesalers for a franchise.

To add another wholesaler for this franchise,

- Type a different wholesaler number in the search field.
- Click Search.
When the search results return,

- Double-click the name to select the wholesaler, or
- Initiate a new search.

The wholesaler is added to results table at the bottom of the screen.

To add territory designations,

- Click the wholesaler # to display the Franchise/Territory screen.

**Note:** You must assign territories for each wholesaler.

![Product Registration](image)

![Franchise Distributors](image)
The Franchise/Territory screen appears. At this screen you can designate all territories in which you want the selected wholesaler to distribute your brand.

**Caution:** Two distributors cannot be assigned the same or overlapping territories for a specific brand. Check territory availability for your brand on the Tax Management Web Reports website in [Franchise Brands by Distributor Detail](#).

**Notes:**
- The capability to assign partial territories is available to anyone assigning territories.
- Military installations can only be assigned to distributors by clicking the Part box beside the Military (MI) territory and typing the names of the military installations in the territory description field.
- If you designate a partial territory but do not enter a description of the partial territory, you will see an advisory message at the top of the screen similar to the message shown below. You will not be able to leave the Franchise/Territory screen until you enter the partial territory description.
To designate territories,

- Click the All or Partial box beside each territory to include.

When you click the partial box, the territory name is underlined.

To add or view a partial territory description,

- Click the underlined territory name.

Return to Franchise distributor’s screen.
The Partial Territories window appears.

The Save button will be active as soon as you type the partial territory description in the text field.

- Type the description of the partial territory.
- Click Save.

**Note:** You can copy existing brand partial territory descriptions from the Tax Management Web Report, [Franchise Designation](#).

The territory description is saved and appears at the bottom of the partial territories window.

- Click Close at the top right side of the window to close the Partial Territories window.

The window will close and you will return to the Franchise/Territory screen.
If you have added all territories for this wholesaler,

- Click the Return to Franchise button at the bottom of the screen.
DESIGNATE MILITARY INSTALLATIONS IN TERRITORIES

If a wholesaler/distributor has military installations in his territory and he wants to distribute to those installations, the installations must be individually assigned at the Military (MI) territory name. You must click the box in the column or you will not be able to designate military installations for distribution. If you click All, there will be no way to designate the installations for distribution.

Caution: Two distributors cannot be assigned the same or overlapping territories for a specific brand. Check territory availability for your brand on the Tax Management Web Reports website in Franchise Brands by Distributor Detail.

Notes:

— The capability to assign partial territories is available to anyone assigning territories.
— Military installations can only be assigned to distributors by clicking the Part box beside the Military (MI) territory and typing the names of the military installations in the territory description field.
— If you designate a partial territory but do not describe the partial territory, you will see an advisory message at the top of the screen similar to the message shown below. You will not be able to leave the Franchise/Territory screen until you enter the partial territory description.

⚠️ Please add Partial Territories for:
At the “Military (MI)” territory name,

- Click the box in the partial column. Military (MI) will be underlined.
- Click the underlined territory name.

![Franchise/Territory Table]

Click the box in the Partial column to assign military installations for distribution.
The Partial Territories window appears.

The Save button will be active as soon as you type the partial territory description in the text field.

- Type the names of the military installations to include.
- Click Save.

**Note:** You can copy partial territory descriptions for existing brands from the Tax Management Web Report, Franchise Designation.

The partial territory description is saved and appears at the bottom of the partial territory window.

- Click Close at the top right side of the window to close the partial territory window.

The window will close and you will return to the Franchise/Territory screen.
If you have added all territories for this wholesaler,

- Click the Return to Franchise button at the bottom of the screen.
The Franchise Distributors screen appears.

If you have added all wholesalers and territories for this brand,

- Click Next.

The View Request screen appears. The summary franchise for this brand is displayed. The request will include all current and previous entries for this brand and user that have been entered into the online system since August 1, 2013. At this screen you can view your request to ensure that all information is correct or you can cancel your request.

If all information for your franchise request is correct,

- Click Submit Request.

To cancel your request,

- Click Cancel.

Note: If you choose Cancel, all entries will be lost and you will be returned to the franchise list.
When your request is submitted, the View Franchise History screen appears. The date and time stamp confirms franchise requests successfully submitted for this brand. If you would like to add or remove applicants or suppliers, or add wholesalers and territories, you may return to the franchise list and repeat the process. All entries will be loaded to the Tax Management Web Reports site overnight.

- Click the magnifying glass to view a summary of your requests.
- Click the hyperlink to view the brand owner’s authorization form for each applicant/licensee.

When franchise history review is complete,

- Click Return to Franchise List.

Click the hyperlink to view the brand owner’s authorization form for each applicant/licensee.
FINISH AND PAY

If you entered Importer/Franchise Registration directly from Label Registration and you have unpaid labels in your Shopping Cart, the Finish and Pay button will be active at the View Request screen.

You will need to pay for the labels before your label and franchise requests can be approved.

- Click Finish and Pay

When you click Finish and Pay your Franchise request will be uploaded and you will be redirected to Shopping Cart to complete the payment transaction.

![View Request](image)

The number of unpaid labels for which you must remit payment appears beside the shopping cart menu option on the left navigation panel on the Product Registration Welcome screen.
To view Franchise History, return to the Importer/Franchise Registration - Franchise Requests list.

- Locate the brand name for the labels and franchise you registered.
- Click the magnifying glass to display Franchise History.
The Franchise History screen appears. The date and time stamp confirms franchise requests successfully submitted for this brand. If you would like to add or remove applicants or suppliers, or add wholesalers and territories, you may return to the franchise list and repeat the process. All entries will be loaded to the Tax Management Web Reports site overnight.

- Click the magnifying glass to view a summary of your requests.
- Click the hyperlink to view the brand owner’s authorization form for each applicant/licensee.

When franchise history review is complete,

- Click Return to Franchise List.
REGISTER A NÉGOCIANT BRAND OWNER, SUPPLIER, AND IMPORTER FOR WINE

At the Welcome Screen, click Importer/Franchise Registration.

Each Virginia applicant/licensee must secure a completed and signed Brand Owner’s Written Authorization to Importer Letter from a négociant brand owner before beginning the Importer/Franchise registration process.
If you have registered a new or revised label on or after August 1, 2013 through the online system, the brand should appear in the list of Franchise Requests. You can add new franchise information, update an existing franchise, or add wholesalers and territories. If the brand does not appear in the list, initiate a brand search.

**Note:** If you search for a brand that is already in the Franchise Requests list you will receive an advisory message similar to the following:

![Image of advisory message]

If the brand/franchise you wish to add or update is not listed,

- Type the full or partial brand name in the search field.
- Click Search.

![Image of brand/franchise registration screen]
The Product Registration search window appears displaying a list of brand names that match your search criteria.

- Double-click the name to select the brand.

**Note:** If the search does not return the results you are expecting, please see Appendix E: Product Registration Search Functionality for help in completing a successful search.
The Importer/Franchise Registration screen appears. The brand you selected is listed at the bottom of Franchise Requests.

- Click the radio button beside the brand to select it.
- Click Add Négociant.

**Notes:**

- If the brand you searched for is a new brand, it will appear at the bottom of the Franchise Requests list.
- If the brand you searched for is an existing brand, it will be listed alphabetically.

The Add Négociant option is available only if the approval type for the selected product is wine and the place of origin is France or Germany.

The Wholesaler/Territory option is not available until négociant brand owner, supplier, and applicant/licensee have been added for a new brand.
If the brand you want is listed and the brand owner is not a négociant,

- Click the radio button beside the brand to select it.
- Click Add Négociant.

If the brand has only négociant brand owners listed and you want to add another négociant brand owner,

- Type the brand name in the Search field.
- Click Search

When the search results appear,

- Double click the name to select it.

You will return to the Franchise Requests list. The brand will be listed in alphabetical order. There will be an “N” beside the brand owner in the Négociant column. The Add Négociant button will be active.

- Click Add Négociant.

**Note:** A brand can have only one brand owner but it can have unlimited négociant brand owners. Each franchise with a négociant brand owner is considered a separate entity.
The Importer/Franchise Registration screen appears. At this screen you can add a négociant brand owner and add or remove:

- suppliers
- applicants/licensees

You can download a blank Brand Owner’s Written Authorization to Importer Letter. Each Virginia applicant/licensee must secure a completed and signed Brand Owner’s Written Authorization from a négociant brand owner before beginning the Importer/Franchise registration process.

**Note:** When you obtain the completed and signed Brand Owner’s Written Authorization to Importer Letter, save the completed and signed form as a PDF so you can upload the form to the applicant/licensee registration at the appropriate time.

- Type the Négociant Brand Owner’s name.
- Click Add.

**Notes:**

- You must add the Négociant Brand Owner before you can add a supplier.
- Each brand owner/négociant brand owner is considered a separate franchise. For one brand there can only be one brand owner and unlimited négociant brand owners. Each négociant brand owner added for a brand must be registered as a separate franchise.
The Product Registration search window appears listing the brand owners who match your search criteria.

- Double-click the name to select the négociant brand owner.

If the search result does not include the name you entered,

- Click Enter as New Brand Owner, or
- Initiate a new search.

**Note:** If the search does not return the results you are expecting, please see Appendix E: Product Registration Search Functionality for help in completing a successful search.

The Importer/Franchise Registration screen appears. Négociant has been added to the Affiliation table.

If you want to change the Négociant Brand Owner before submitting the registration,

- Type the new name in the search field.
- Click Search.

When the search result appears,

- Double-click the name to select the brand owner.

The new entry will overwrite the current entry.

You may also delete the brand owner and add a new one.
ADD A SUPPLIER

- Click the radio button to specify whether the négociant brand owner and the supplier are the same.

If you click “yes” to specify that the négociant brand owner and the supplier are the same, the négociant will be added to the Affiliation table as supplier.
If you click “No” to specify the négociant brand owner and supplier are not the same, a search field opens on the screen so you can search for and add a supplier.

**Note:** Each franchise must have at least one supplier.

- Type the full or partial name of the Supplier.
- Click Add.

**Notes:**
- You can add more than one supplier.
- You must specify whether the brand owner and supplier are the same for each supplier added.
The Product Registration search window appears listing the supplier who matches your search criteria.

- Double-click the name to select the supplier.

Note: If the search does not return the results you are expecting, please see Appendix E: Product Registration Search Functionality for help in completing a successful search.

If the supplier is not found,
- Click Enter as New Supplier, or
- Type a different name,
- Click Search.

When the results from the search are returned,
- Double-click the name to select the supplier.
The Importer/Franchise screen appears. The new supplier is listed in the Affiliation table.

- To add more suppliers, repeat the steps to Add a Supplier beginning on page 111 until all suppliers have been added.

**Note:** As you add each supplier, click the radio box to indicate whether the Négociant Brand Owner and the supplier are the same.
**ADD APPLICANT/LICENSEE VIRGINIA WINE IMPORTERS**

Each Virginia applicant/licensee must secure a completed and signed Brand Owner’s Written Authorization to Importer Letter before beginning the Importer/Franchise registration process.

**Note:** When you obtain the completed and signed Brand Owner’s Written Authorization to Importer Letter, save the completed and signed form as a PDF so you can upload the form to the applicant/licensee registration at the appropriate time.

- Type the applicant’s license number.
- Click Add.

**Note:** You can add more than one importer.

Click [here](#) to download a blank Brand Owner’s Written Authorization form from Tax Management Web Reports.

Type the applicant’s license number.
The Product Registration search window appears listing the applicants who match your search criteria.

- Double-click the name to select the applicant.

**Note:** If the search does not return the results you are expecting, please see Appendix E: Product Registration Search Functionality for help in completing a successful search.

**CAUTION:** You must enter a license ID that is relevant to the product type. If you are adding a franchise for wine, you must enter a license ID for a wine product type. If you enter a license ID for a different product type, such as beer, you will receive an advisory message similar to the message shown on the screen below.

You can obtain the correct wholesaler license number by contacting the Virginia ABC Tax Management office in Richmond, or by accessing Tax Management Web Reports. At the Web Reports screen, click Suppliers, Importers, Retailers to display the Report Type screen. Click the arrow to display the drop-down list. Select Importer – In-State or Importer – Out of State for the appropriate product type. Click Submit. A list of in-state or out-of-state importers appears.
The Importer/Franchise Registration screen appears. The applicant has been added to the table at the bottom of the screen.

Click the applicant number to view the importer’s information.

Importer Information displayed when you click the applicant’s number.
A field opens on the screen so you can browse for and upload the Brand Owner’s Written Authorization to Importer Letter.

- Click Browse to locate the signed Brand Owner’s Written Authorization.

When the authorization is located,

- Click Upload to add the authorization to this application.

**Caution**: If you do not click Upload, the authorization form will not be saved to the franchise application.

**Note**: If the Brand Owner’s Written Authorization is required, you must upload the authorization:

- for each applicant/licensee added,
- before you can update wholesalers/territories, and
- before you review and submit your registration.
The Importer/Franchise screen refreshes. The Brand Owner’s Written Authorization has been added to the table at the bottom of the screen beside the applicant/licensee. Click the magnifying glass to view the authorization form.

To add applicant/licensees,

- Repeat the steps to Add Applicant/Licensee beginning on page 115 for each additional applicant/licensee.

If you want to update wholesaler/Territories,

- Click [Update Wholesaler/Territories].

If you do not want to update wholesaler/territories but you want to submit your franchise request,

- Click [Review and Submit] to update supplier and applicant/licensee.
UPDATE WHOLESALER/TERRITORIES

You may add wholesalers at two points in the application: to an existing brand from the Franchise Requests list, or as part of the franchise registration process.

**Caution:** You cannot delete a wholesaler or his territories after the franchise registration has been submitted. You may add counties or independent cities if the counties or cities have not been assigned to another wholesaler. If you wish to remove a wholesaler or territory, you will need to obtain a release letter from the wholesaler to whom the territory is currently assigned. Or the territory can be deleted in accordance with 4.1.407 (wine) or 5.1-506 (malt beverage) of the Code of Virginia.

To update wholesaler/territories for an existing brand,

- Click Update Wholesaler/Territories at the bottom of the Importer/Franchise Registration screen.
To add wholesaler/territories while adding a franchise,

- Click Update Wholesaler/Territories at the Importer/Franchise Registration screen after you add applicant/licensees.
The Franchise Distributors window appears.

**Notes:**
- If a wholesaler of a brand/product type has the entire state assigned, no other wholesaler can be assigned for the same négociant brand owner. If this condition exists, search functionality will not be available.
- If a wholesaler has been assigned certain territories for a brand/product type, the assigned territories cannot be assigned to a different wholesaler. The assigned territories will be “grayed” out.

**Caution:** Two distributors cannot be assigned the same or overlapping territories for a specific brand. Check territory availability for your product on the Tax Management Web Reports website in Franchise Designation.

The product registration search window appears listing wholesalers who match your search criteria.

- Double-click the name to select the wholesaler.

- Type the wholesaler name or the license ID for the wholesaler you are authorizing.
- Click Search.
**Caution:** You must enter a license ID that is relevant to the product type. If you are adding a franchise for wine, you must enter a license ID for a wine product type. If you enter a license ID for a different product type, such as malt beverage, you will receive an advisory message similar to the message shown on the screen below.

**Note:** You can obtain the correct wholesaler license number by contacting the Virginia ABC Tax Management office in Richmond, or by accessing Tax Management Web Reports. At the Web Reports screen, click **Suppliers, Importers, Retailers** to display the Report Type screen. Click the arrow to display the drop-down list. Select Importer – In-State or Importer – Out of State for the appropriate product type. Click Submit. A list of in-state or out-of-state importers appears.

The Franchise Distributors screen appears. The wholesaler you selected has been added to the Results table.

**Note:** You may add several wholesalers for a franchise.

To add another wholesaler for this franchise,

- Type a different wholesaler number in the search field.
- Click Search.

When the search results return,

- Double-click the name to select the wholesaler, or
- Initiate a new search.
The Franchise Distributors screen appears. The wholesaler you selected has been added to the Results table.

- Click the Wholesaler number to add territories for this brand.

Click X to remove the wholesaler.
The Franchise/Territory screen appears. At this screen you can designate all territories in which you want the selected wholesaler to distribute your brand.

**Caution:** Two distributors cannot be assigned the same or overlapping territories for a specific brand. Check territory availability for your product on the Tax Management Web Reports website in [Franchise Designation](#).

**Notes:**

— The capability to assign partial territories is available to anyone assigning territories.
— Military installations can only be assigned to distributors by clicking the Part box beside the Military (MI) territory and typing the names of the military installations in the territory description field.
— If you designate a partial territory but do not enter a description of the partial territory, you will see an advisory message at the top of the screen similar to the message shown below. You will not be able to leave the Franchise/Territory screen until you enter the partial territory description.

⚠️ Please add Partial Territories for: [Name]
To designate territories,

- Click the All or Partial box beside each territory to include.

When you click the partial box, the territory name is underlined.

To add or view a partial territory description,

- Click the underlined territory name.

```
<table>
<thead>
<tr>
<th>Territory</th>
<th>All?</th>
<th>Part?</th>
</tr>
</thead>
<tbody>
<tr>
<td>STATE OF VIRGINIA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COLONIAL HEIGHTS (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COOPER (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DICKINSON (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HIGHLAND (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JAMES CITY (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>KING WILLIAM (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LEXINGTON (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LUNENBURG (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MANASSAS (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MATHews (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MILITARY (D)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NEW KENT (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NORTHAMPTON (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STAUNTON (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUSSEX (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WARREN (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WESTmoreLAND (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WISE (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACOMACK (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COWING (NC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUMBERLAND (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DYNAMMIE (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HOPFELD (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>KING AND QUEEN (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MANSAS PARK (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MECKLENBURG (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MONTGOMERY (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NEWPORT NEWS (NC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NORTHUMBERLAND (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUFFOLK (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TAPEYELL (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WASHINGTON (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WILLIAMSBURG (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WITHE (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALBERMARLE (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRAIG (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DAVENILLE (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENFORDA (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISLE OF WICTH (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LEE (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOULISA (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MADISON (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MARTINSVILLE (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MIDDLE (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NELSON (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NORFOLK (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NORT (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SURRY (CO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIRGINIA BEACH (NC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WAYNESCOUR (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WINCHESTER (IC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>YORK (CO)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```
The Partial Territories window appears.

The Save button will be active as soon as you type the partial territory description in the text field.

- Type the description of the partial territory.
- Click Save.

**Note:** You can copy existing brand partial territory descriptions from the Tax Management Web Report, Franchise Designation.

The territory description is saved and appears at the bottom of the partial territory window.

- Click Close at the top right side of the window to close the Partial Territories window.

The window will close and you will return to the Franchise/Territory screen.
If you have designated all territories and partial territories,

- Click the Return to Franchise button at the bottom of the page to return to the Franchise Distributor’s screen to add more wholesalers and distributors or confirm your franchise

**Note:** If you designate a partial territory but do not describe the partial territory, you will see the following advisory message at the top of the screen. You will not be able to leave the Franchise/Territory screen until you enter the partial territory description.
DESIGNATE MILITARY INSTALLATIONS IN TERRITORIES

If a wholesaler/distributor has military installations in his territory and he wants to distribute to those installations, the installations must be individually assigned at the Military (MI) territory name. You must click the box in the Part column or you will not be able to designate military installations for distribution. If you click All, there will be no way to designate the installations for distribution.

Caution: Two distributors cannot be assigned the same or overlapping territories for a specific brand. Check territory availability for your product on the Tax Management Web Reports website in Franchise Designation.

Notes:

— The capability to assign partial territories is available to anyone assigning territories.
— Military installations can only be assigned to distributors by clicking the Part box beside the Military (MI) territory and typing the names of the military installations in the territory description field.
— If you designate a partial territory but do not enter a description of the partial territory, you will see an advisory message at the top of the screen similar to the message shown below. You will not be able to leave the Franchise/Territory screen until you enter the partial territory description.

⚠️ Please add Partial Territories for: [Blank]
At the “Military (MI)” territory name,

- Click the box in the partial column. Military (MI) will be underlined.
- Click the underlined territory name.

Click the box in the Partial column to assign military installations for distribution.
The Partial Territories window appears.

The Save button will be active as soon as you type the partial territory description in the text field.

- Type the names of the military installations to include.
- Click Save.

**Note:** You can copy existing brand partial territory descriptions from the Tax Management Web Report, Franchise Designation.

The partial territory description is saved and appears at the bottom of the partial territories window.

- Click Close at the top right side of the window to close the Partial Territories window.

The window will close and you will return to the Franchise/Territory screen.
**Note:** If you designate a partial territory but do not describe the partial territory, you will see an advisory message at the top of the screen similar to the message shown below. You will not be able to leave the Franchise/Territory screen until you enter the partial territory description.

⚠ **Please add Partial Territories for:**
If military designations are complete,

- Click the Return to Franchise button at the bottom of the page to return to the Franchise Distributor’s screen to add more wholesalers and distributors or confirm your franchise request.
If you have added all wholesalers and distributors for this brand,

- Click Next to go to the confirmation page to view your request.
The View Request screen appears. At this screen you can cancel your franchise request or you can review your request and, if all information is correct, click Submit Request.

- Review request.

If all information is correct,

- Click Submit Request.

**Note:** If you choose Cancel, all entries will be lost and you will be returned to the franchise list.
When your request is submitted, the View Franchise History screen appears. The date and time stamp confirms franchise requests successfully submitted for this brand. If you would like to add or remove applicants or add wholesalers and territories, you may return to the franchise list and repeat the franchise registration process. All entries will be loaded to the Tax Management Web Reports site overnight.

- Click the magnifying glass to view a summary of your requests.
- Click the hyperlink to view the brand owner’s authorization form for each applicant/licensee.

When franchise history review is complete,

- Click Return to Franchise List.
FINISH AND PAY

If you entered Importer/Franchise Registration directly from Label Registration and you have label registration requests in your shopping cart, the Finish and Pay button will be active at the View Request screen.

You will need to pay for the labels before your label and franchise requests can be approved.

- Click Finish and Pay

When you click Finish and Pay your Franchise request is uploaded and you will be re-directed to Shopping Cart to complete the payment transaction.

The number of unpaid labels for which you must remit payment appears beside the shopping cart menu option on the left navigation panel on the Product Registration Welcome screen.
To view Franchise History, return to the Importer/Franchise Registration Franchise List.

- Locate the brand name for the labels and franchise you registered.
- Click the magnifying glass to display Franchise History.

Once you have selected a Franchise, click the appropriate button to Add or update with your request.
The Franchise History screen appears. The date and time stamp confirms franchise requests successfully submitted for this brand. If you would like to add or remove applicants or add wholesalers and territories, you may return to the franchise list and repeat the process. All entries will be loaded to the Tax Management Web Reports site overnight.

- Click the magnifying glass to review a summary of your request.
- Click the hyperlink (applicant/licensee Virginia importer’s name) to view the brand owner’s authorization form.
MANAGE ACCOUNT

At the Welcome screen,

- Click Manage Account

The Manage Account screen appears. Options for managing your account are listed.

- Click to select an option.

Click Logout to log out of the application.

Click Feedback to complete the feedback survey for the application and user guide.

Click Help to open the Product Registration User Guide.
**PAYMENT HISTORY**

- Select Payment History, to see your payment history for the specified date range. You can filter or sort by Transaction ID, Status, or date. You may choose all or multiple filters to narrow your search.

To filter transactions by Transaction ID:

- Type the Transaction ID in the Transaction field.
- Click Filter.

A filter by Transaction ID will return a list containing the item that matches the Transaction ID you entered.
To filter transactions by Status

- Select the filter Status from the drop down list. Status options are: Pending Payment, Pending Receipt, Paid, Payment Failed, Cancelled, and Unknown.
- Click Filter.
- Click the magnifying glass beside each transaction to view the payment history.

Note: You will receive an advisory message if there are more than 50 requests matching your search criteria. If you receive this message, please choose multiple filters to narrow your search.

**UPDATE CONTACT INFORMATION**

To update contact information

- Click Update contact information.
The Update contact information screen appears.

- Revise contact information as required.
- Click Submit.

Contact information will be saved.

**UPDATE ADDRESS INFORMATION**

To update address information

- Click Update address information.
The Update Address Information screen appears

- Revise address information as required.
- Click Submit

Address revisions will be saved.

CHANGE PASSWORD

To change your Account Central password

- Click Change Password
The Change Password screen appears

- Type your old password.
- Type your new password.
- Type your new password again to confirm.
- Click Submit.

You will receive confirmation that your password has been changed.

**UPDATE SECURITY QUESTIONS**

- Click Update security questions.
The Update security questions screen appears.

**Note:** You may update any or all of the questions.

- Click to select one of the questions and update the answer.
- Click Update

Select the next question to update and type the answer.
- Click Update.
- Continue until you have updated questions as required.

You will receive confirmation that each question has been updated.
ASSOCIATED ACCOUNTS

The following information provides the steps to associate related accounts and reasons for associating related accounts.

To associate related accounts,
- Click Associate Related Accounts.

The Associated Accounts screen appears.

- Click Create New Association.

Notes:

— When an account is created by a user who enters all the information for label approval/franchise but is not authorized to make payments, he can authorize another user to have access to his account to authorize payment through Associated Accounts in the Product Registration system.

— If an account holder leaves a company and he has associated another user in the company, then the associated employee can have access to the Product Registration to view work started by first employee.

— If you associate an account holder and he has associated someone else, then both parties have access to your account.

— If an account holder associates you to share their account, you do not have to associate them to share your account.
The E-mail address field appears.

![Add an Association](image)

- Type the email address for the account with which you want to create an association.
- Click Verify.

If the account you want to associate is a registered user of Product Registration, the following screen appears.

![Please confirm that the selected user will be associated to your account](image)

If you want to give this account access to your Product Registration requests and the requests of all of your other associated accounts,

- Click Send.

To cancel the request,

- Click Cancel.

You will receive verification if the association is successful.

If the email address for the account you want to associate does not belong to a registered user of Product Registration, you will see the following advisory message:

![The email address provided is not associated to an existing Product Registration Account or User. Please have the Associate register as a user to access the Product Registration system.](image)
**Glossary**

**Appellation:** Appellation of origin is simply another name for the place in which the dominant grapes used in the wine are grown. It can be the name of a country, state, county or geographic region called viticulture area.

**Beer:** Any alcoholic beverage obtained by the fermentation of an infusion of or decoction of barley, malt, and hops or any similar products in drinkable water and containing one-half of one percent or more of alcohol by volume.

**Beer Wholesaler, wholesaler, beer distributor and distributor:** Any wholesale beer licensee, including any successor-in-interest to such a person, within the Commonwealth offering beer for sale or resale to retailers or other beer wholesalers without regard to whether the business of the person is conducted under the terms of an agreement with a licensed brewery.

**Brand Agent:** A brand agent is any person that a manufacturer has authorized to engage in a business consisting in whole or in part of the sale and distribution of its alcoholic beverage products and trademarks with authority to appoint wholesale distributors, assign territories, and file price postings in Virginia.

**Brand Extension (or extension of a brand):** Any brand which incorporates all or a substantial part of the unique features of a pre-existing brand of the same brewery or winery and which relies to a significant extent on the good will associated with such pre-existing brand.

**Brand Name:** Any word, name, group of letters, symbol or combination thereof adopted and used by a brewery or winery to identify a specific product and to distinguish that product from other products produced or marketed by that brewery or winery. The use of general corporate logos or symbols or the use of advertising messages, whether appearing on the product packaging or elsewhere, shall not be considered to be a brand name. A Brand Name can sometimes be a Trademark.

**Brand Owner:** The company name printed on the label as the producer, bottler, brewer, proprietor, viticulture, winery, vineyard, winegrowers’ cooperative, Chateau or Domaine.

**Brand Type:** Brand type is a combination of the varietal, fanciful name, color and the appellation if imported. This includes (V) if vintage or (NV) if non-vintage.

**Brewery:** Every person, including any authorized representative of such person (pursuant to 4.1-218) which is licensed as a brewery located within the Commonwealth, which holds a beer importer’s license and is not simultaneously licensed as a beer wholesaler or which manufactures any malt beverage, has title to any malt beverage products excluding licensed Virginia wholesalers and retailers or has the contractual right to distribute under its own brand any malt beverage product whether licensed in the Commonwealth or not, who enters into an agreement with any beer wholesaler licensed to do business in the Commonwealth.
Cider: Any beverage, carbonated or otherwise, obtained by the fermentation of the natural sugar content of apples containing not more than 10% of alcohol by volume without chaptalization or containing not more than 7% of alcohol by volume regardless of chaptalization.

Chaptalization: A method of increasing the alcohol in a wine by adding sugar to the grape juice before or during fermentation to increase the alcohol content.

Combination/Gift Pack: Any combination of approved products sold as a single package. Such package can contain non-alcoholic merchandise such as glasses, crackers, and other wine related items. The non-alcoholic merchandise and wine must be packaged together so that the package is designed for the benefit of the consumer, and not detached for use by retailers or their employees. The wine tax should be on that portion of the total price which accounts for the wine only; the non-alcoholic merchandise should not be taxed as wine. Combination packaging shall be limited to packaging provided by the manufacturer that is designed to be delivered intact to the consumer.

Compliance Agent (Non-ABC): Any entity, supplier, importer and any person that a brewery, winery, or brand owner has empowered to apply for and obtain any and all federal label approvals, state registrations, and/or documents necessary or appropriate for use in the importation, distribution, and sale of its products in the Commonwealth of Virginia.

De-Listed: A product has not been sold in Virginia to a wholesaler for a period of two years. A product stays on de-listed status for two years. If the product is not purchased by a Virginia wholesaler or re-certified for another two years (total of four years), the product is deleted from the Tax System and if the supplier wishes to sell the wine in the future a complete application is required.

Farm Winery: Means an establishment located on a farm in the Commonwealth with a producing vineyard, orchard, or similar growing area and with facilities for fermenting and bottling wine on the premises where the owner or lessee manufactures wine that contains not more than 18 percent alcohol by volume or located in the Commonwealth with a producing vineyard, orchard, or similar growing area or agreements for purchasing grapes or other fruits from agricultural growers within the commonwealth, and with facilities for fermenting and bottling wine on the premises where the owner or lessee manufactures wine that contains not more than 18 percent alcohol by volume. As used in this definition, the terms “owner” and “lessee” shall include a cooperative formed by an association of individuals for the purpose of manufacturing wine. In the event such cooperative is licensed as a farm winery, the term “farm” as used in the definition includes of the land owned or leased by the individual members of the cooperative as long as such land is located in the Commonwealth.
**Franchise Beer Agreement:** Means a commercial relationship, not required to be evidenced in writing, of definite or indefinite duration, between a brewery and beer wholesaler pursuant to which the wholesaler has been authorized to distribute one or more of the brewery’s brands of beer. The doing or accomplishment of any of the following acts shall constitute prima facie evidence of an agreement within the meaning of this definition: (1) The shipment, preparation for shipment or acceptance of any order by any brewery for any beer to a beer wholesaler within the Commonwealth. (2) The payment by a beer wholesaler and the acceptance of payment by any brewery for the shipment of an order of beer intended for sale in the Commonwealth.

**Franchise Wine Agreement:** Means a commercial relationship, not required to be evidenced in writing, of definite or indefinite duration, between a winery and wine wholesaler pursuant to which the wholesaler has been authorized to distribute one or more of the winery’s brands of wine. The doing or accomplishing of any of the following acts shall constitute prima facie evidence of an agreement within the meaning of this definition: (1) The shipment, preparation for shipment or acceptance of any order by a winery for any wine to a wine wholesaler within the Commonwealth. (2) The payment of a wine wholesaler and the acceptance of payment by any winery for the shipment of an order of wine intended for sale in the Commonwealth.

**Importer:** A licensed wine or beer entity within or outside the Commonwealth that sells and delivers or ships wine or beer, in accordance with Board regulations, in closed containers, to persons in the Commonwealth licensed to sell wine or beer at wholesale for the purpose of resale, and to persons outside the Commonwealth for resale outside the Commonwealth.

**Label:** Anything functioning as a means of identification, such as a piece of paper or other material affixed to a container or printed directly on the container to designate its origin, owner, contents, and alcohol by volume, appellation, importer, and government warnings.

**Low Alcohol Beverage:** Means a drink containing one-half of one percent or more of alcohol by volume, but not more than seven and one half percent by volume, and consisting of spirits mixed with nonalcoholic beverages or flavoring or coloring materials; it may also contain water, fruit juices, fruit adjuncts, sugar, carbon dioxide, preservatives or other similar products manufactured by fermenting fruit or fruit juices.

**Négociant Brand Owner:** A wine merchant who purchases wine from French or German Wineries in bulk and takes title of such and places it in his own cellars for aging and sale.

**Product Approval:** When an application submitted by an entity or person to the board to obtain approval of each new brand and type of wine, beer, low alcoholic beverage and cider they wish to offer for sale in the Commonwealth or approval of changes made to an existing approval has been approved by the ABC Department and an approval code has been issued for the product to be sold in Virginia.
Product Registration: An application submitted by an entity or person to the board to obtain approval of each new brand and type of wine, beer, low alcoholic beverage and cider they wish to offer for sale in the Commonwealth or to obtain approval of changes made to an existing approval.

Supplier: A wine or beer entity outside the Commonwealth that sells and delivers or ships wine or beer, in accordance with Board regulations in closed containers to licensed importers in the Commonwealth.

Territory: The area of primary sales responsibility within the Commonwealth expressly or implicitly designated by any agreement between any wine wholesaler and winery for the brand or brands of any winery or any beer wholesaler and brewery for the brand or brands of any brewer.

Unlicensed Supplier: A wine or beer entity outside the Commonwealth that sells and delivers or ships wine or beer, in accordance with Board regulations in closed containers to licensed importers in the Commonwealth and does not hold a Virginia importer’s license. The Unlicensed Supplier is assigned a number by the ABC Department to identify the entity as an Unlicensed Supplier.

Varietal: Varietal designations are the names of the dominant grapes used in the wine. Cabernet Sauvignon, Chardonnay, Zinfandel and Merlot are examples of grape varieties.

Wine: Any alcoholic beverage obtained by the fermentation of the natural sugar content of fruits or other agricultural products containing (i) sugar, including honey and milk, either with or without additional sugar; (ii) one-half of one percent or more of alcohol by volume; and (iii) no product of distillation. The term includes any wine to which wine spirits have been added, as provided in the Internal Revenue Code, to make products commonly known as “fortified wine” which do not exceed an alcohol content of 21 percent by volume.

Wine Wholesaler: A wine wholesaler is any wholesale wine licensee offering wine for sale or resale to retailers or other wine wholesalers without regard to whether the business of the person is conducted under the terms of an agreement with a licensed winery.

Winery: Every person, including any authorized representative of such person, (pursuant to 4.1-218) which enters into an agreement with any Virginia wholesale wine licensee and is licensed as a winery or is licensed as a Virginia farm winery, is licensed as a wine importer and is not simultaneously licensed as a wine wholesaler, manufactures or sells any wine products, whether licensed in the Commonwealth or not, or without regard to whether such person is licensed in the Commonwealth, has title to any wine products, excluding Virginia wholesale licensees and retail licensees, and has the manufacturer’s authorization to market such products under its own brand or the manufacturer’s brand.
APPENDIX A: SIGN UP FOR AN ACCOUNT CENTRAL ACCOUNT

At the Account Central Log in screen:

- Click Sign up for an Account Central Account.

The Create a new user account – Disclaimer screen appears.

- Click Accept.
The Create a new user account screen appears.

- Click the radio button to confirm that you have an email address.

The Create a new user account – Contact information screen appears.

- Complete the required fields.
- Click Continue.
- You must enter an email address for access to Product Registration to be considered.
The Create a new user account – Security questions screen appears.

- Select a question from the drop-down list for each question.
- Type an answer.
- When all five questions have been answered,
- Click Continue.
The Create a new user account – User credential screen appears.

- Type your login ID, password and password confirmation.

Login ID must be at least six characters.

- Click Submit.

The Account Central Log in screen appears.

- Type your Login ID and password.
- Click Login.
The Welcome to Virginia ABC Product Registration screen appears.

- Click the Request Access button to request access to register alcoholic beverages.
The Request Access to Product Registration screen appears.

- Complete Account Information and Address Information.
- Click the Submit button.

The Request Access to Product Registration screen appears with a message advising that your “Request for access has been submitted.”
## APPENDIX B: EXISTING BRANDS – NEW LABEL OR REVISED LABEL?

Reference this table to determine whether to register a new label for new or existing brand type or revise a label for an existing brand type.

<table>
<thead>
<tr>
<th>You will need a new label if you are:</th>
<th>You will need a revised label if you are:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Adding a vintage year for a label that is not approved for a vintage year.</td>
<td>• Adding a new vintage year to a label already approved for a vintage year.</td>
</tr>
<tr>
<td>• Adding a new brand type.</td>
<td>• Adding a new applicant to an approved label.</td>
</tr>
<tr>
<td>• Adding a new varietal.</td>
<td>• Adding a new container size to a label such as 750 ml or 1.5 liters.</td>
</tr>
<tr>
<td>• Adding, deleting, or changing an appellation for an imported wine.</td>
<td>• Adding new graphic to an approved label.</td>
</tr>
<tr>
<td>• Adding, deleting, or changing a fanciful name.</td>
<td>• Adding, deleting or changing an appellation for a domestic wine.</td>
</tr>
<tr>
<td>• Changing a brand type description such as chardonnay to chardonnay reserve.</td>
<td></td>
</tr>
<tr>
<td>• Adding, deleting, or changing words in a previously approved label.</td>
<td></td>
</tr>
</tbody>
</table>
APPENDIX C: HOW TO SCAN YOUR LABELS TO ENSURE READABILITY

1. Scan the complete set of labels (front, back, neck, and any other labels affixed to the bottle) into one in JPEG format only.
2. Scan the label’s actual size. Do not enlarge the label. (The preferred sizes are 750 ML for wine and 12 Oz for beer.
3. Scan in high resolution (clear detail).
4. Crop the labels when scanning.
5. Ensure no part of the labels is cut off.
APPENDIX D: REQUIREMENTS FOR COMBINATION PACKAGES AND GIFT PACKAGES APPROVAL

1. All packages must be submitted for approval and registration before they can be sold to retailers. If the products are not approved, please obtain approval prior to submitting the Combination/Gift Pack.

2. All Combination Packages and Gift Packages must be submitted for review as they will be marketed to Virginia Retailers. The Outside of the package must clearly state the Brand Name and complete Brand Type. In addition to listing the Fanciful Name, the type must be listed as well i.e., Ale, Stout, Lager, for beer products or Chardonnay, Merlot, Zinfandel for wine products, etc. Specifically, we require the physical bottles inside the package (preferably empty bottles), and legible brochure type artwork (on 8.5 x 11 piece of paper) of the outside of the package must also be submitted. The Combination Package or Gift Package will not be approved if the physical package as it will be marketed to Retailers is not received.

3. A fee in the amount of $30.00 should be remitted for each Combination and/or Gift Package submitted. The fee is non-refundable and non-transferrable.

4. If the package contains one product of six, twelve or twenty-four bottles, etc. that will not be sold as a Gift Package, it does not need to be approved, use the approval code assigned to the individual product.

5. If the Beer Combination Package contains a rotating seasonal product, each rotating seasonal product must obtain a separate ABC approval code per each seasonal package. For example, Brand Name: Bill’s Brewery: Twelve Bottle Brewer’s Choice Spring Variety Pack, Twelve Bottle Brewer’s Choice Summer Variety Pack, Twelve Bottle Brewer’s Choice Fall Variety Pack, Twelve Bottle Brewer’s Choice Winter Variety Pack would cost $120.00 ($30 x 4).

6. If the Cider/Wine Combination Package contains a rotating seasonal product, each rotating seasonal product must obtain a separate ABC approval code per each seasonal package. For example, Brand Name: Cindy’s Cider: Twelve Bottle Cider Maker’s Choice Pear Variety Pack, Twelve Bottle Cider Maker’s Choice Apple Variety Pack, Twelve Bottle Cider Maker’s Choice Raspberry Variety Pack would cost $90.00 ($30 x 3).
APPENDIX E: PRODUCT REGISTRATION SEARCH FUNCTIONALITY

Search functionality in Product Registration matches the search condition (the grouping of letters, words, or numbers) entered in the search field to brand names, license identification numbers, or company names in the application database. A search returns a list of all names that contain the grouping of letters, numbers, or names you included in the search condition. The list will be in alphabetical order. If the list is long, use the scroll bar to scroll through the list or use the pagination arrows to find the correct name. The search function is not case sensitive so you can type the search condition in upper or lower case letters.

Search for a Brand Name

If you are searching for a brand name that has more than one word, such as Twisted Tea,

- Type “Twisted” in the search field.
- Click Search.

The search returns a list of seven items that match your search condition. Twisted Tea is listed.

However,

- Type “Twisted Tea” in the search field.
- Click Search.

The search reads both words and returns an alphabetized list containing more than 1400 items. The list includes all names in the database that have either Twisted or Tea anywhere in the name.
Another example of a brand name search:

If you are searching for a malt beverage called Shock Top,

- Type “Sho” in the search field. Click Search.
- The search returns a list that contains all brand names that contain the letters “Sho,” including Shock Top.
• Type Shock in the search field.
• Click Search Brand.

The search returns Shock Top, which is the only brand name containing the word shock.

However, if your search condition is “Shock Top,” the search will return all names that contain either shock or top, including the Shock Top brand. There is only one brand that contains the word “shock” but there are many brands that contain the word “top.”
Search for a License ID

If your search condition is a numeric license ID,

- Type the correct license ID.
- Click Search.

The search will return an exact match.

The search will not find a match for a partial numeric license ID.
However, if the license ID begins with X (unlicensed wine wholesaler) or B (unlicensed beer wholesaler), enter X or B in the search field and the search will return all licensees with IDs that begin with X or B.

**Search for a Company Name**

If you are searching for the company named Anheuser Busch, and you type “An” in the search field, your search will return an alphabetized list of all company names that contain the letters “An” anywhere in the name. In this case the search returned a list with 1572 items. Each page of the list contains 25 items. Anheuser Busch appears on page 4. The key is to enter enough characters to retrieve either an exact match to the name you want or a short list that contains the name you want.

You don’t have to enter the full name for the search to return a match. Sometimes you can enter few letters and the search will return the company name.
Search Limitations

1. The ampersand (&) is the only special character recognized by the search function in Importer/Franchise Registration. You will often see the ampersand (&) in company names such as E & J Gallo.

- Type “&” in the search field.
- Click Search.

The search returns an alphabetized list of all company names containing an ampersand.

- Type “E & J” in the search field.
- Click Search.

The search returns an alphabetized list of names ending with “e” and beginning with J.

The names in the list match the group of letters and symbols in your search condition.
If you want to retrieve E & J Gallo,

- Type E & J Gallo in the search field.
- Click Search.

The search returns a list of all names containing Ernest & Julio Gallo and Gallo.

2. Make sure you enter the correct search condition in the correct field. Searching for a brand name in the company trade name or license ID search will not be successful. Each search accesses a specific database and each database has validations. Validations apply to any search on brand, applicant, applicant/licensee, supplier and wholesaler/distributor. For example, if you attempt a search for an applicant/licensee, only active and pending licenses for the product type of the brand will be returned.

3. The applicant/licensee and wholesaler/distributor searches do not recognize partial license IDs but those searches will recognize numbers that are part of a company name in the applicant/licensee search or a brand in the brand name search. Some examples are the company name, 16 Hands Brewing Company, or brand names 14 Hands, 29 Vines and 4 Seasons.

For instance,

- Type the number 16+space.
- Click Search Brand.
In the brand name search, if you are searching for Cristobal 1492,

- Type 1492+space in the search field.
- Click Search Brand

The search returns Cristobal 1492.
APPENDIX F: OBTAIN A BRAND OWNER’S WRITTEN AUTHORIZATION TO IMPORTER LETTER

Each Virginia applicant/licensee must have a completed and signed Brand Owner’s Written Authorization to Importer Letter before beginning the Importer/Franchise registration process, if a Brand Owner’s Written Authorization to Importer Letter is required.

A Brand Owner’s Written Authorization to Importer Letter is always required from négociant brand owners.

A Brand Owner’s Written Authorization is not required if the brand owner and applicant are the same, or if the brand owner is a Virginia Winery, Farm Winery, or Brewery.

To obtain a Brand Owner’s Written Authorization to Importer Letter,

- Click the Tax Management Web Reports link on the Product Registration welcome screen.
The Tax Management index of web reports appears.

Under Franchise Information,

- Click Brand Owner’s Written Authorization to Importer Letter.
The Brand Owner’s Written Authorization to Importer Letter appears.

- Save or print the form as required.